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FreeDOS Installation CD Version 0.91 Beta 
 
Installing FreeDOS (or MSDOS) on a Windows XP Computer 
 
You can install FreeDOS (or MSDOS) on almost any WindowsXP computer in under an 
hour and WITHOUT having to reinstall WindowsXP!  This procedure will show you 
how to dual-boot your computer.  When you turn your computer on, you decide whether 
to run FreeDOS or WindowsXP!  When you are done, you will see a screen like the 
following: 
 

 
 
All you need is access to a high-speed internet connection to download a 40 MByte CD 
image, a CD burner, and a blank CD. 
 
Your computer must be able to boot from a CD drive…almost all modern computers 
can…and boot from an IDE or SATA hard disk drive.  Almost all computers use one of 
these types of drives.  If you are using a SCSI drive or a RAID array, this technique may 
not work for you. 
 
You can use this procedure to install either FreeDOS or MSDOS 7.1.   The installation 
CD and procedure are written for FreeDOS.  MSDOS installation is described in an 
Appendix. 
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What are you going to do?  
 
There are five basic steps necessary to install FreeDOS on your WindowsXP computer. 
 

1. Shrink the WindowsXP disk partition by 500 Mbytes (a trivial amount). 
2. Create a new partition of type Windows 95 FAT32 (LBA) 
3. Install and configure the GAG boot loader 
4. Boot DOS and do a “sys” command to install it on the new partition 
5. Copy some basic DOS files to the new partition and create autoexec.bat and 

config.sys files. 
 
Everything you need to do this and install FreeDOS is available on a single bootable CD 
which you can download for free from http://odin.fdos.org/dual/fdinst091.iso. 
 

FAQ (Frequently Asked Questions) 
 
1.  Why don't you just use the official Microsoft procedure for dual-booting Windows XP 
and DOS? 
 
For the Microsoft procedure, see: 
http://www.microsoft.com/windowsxp/using/setup/lear nmore/multiboot.mspx 
 
The Microsoft procedure works fine.  However, it requires destroying the existing 
Windows XP installation, installing DOS, and then reinstalling Windows XP.  The 
computers I am dealing with have Windows XP pre-installed and I am not willing to 
destroy the existing installation.  This procedure adds DOS without affecting the 
Windows XP installation. 
 
2. Why don't you just use a commercial package to re-partition the disk and dual boot? 
 
I used to use Partition Magic for this.  However, Partition Magic 8.02 did not successfully 
resized most of the NTFS partitions I tested it with so I sent it back.  Also, Partition 
Magic's license agreement required buying a separate license for each computer I wanted 
to dual boot.  The open source tools I am using, including ntfsresize, GParted, and the 
GAG boot loader, are stable and widely used by people who want to dual-boot Linux and 
Windows XP.  They are also available free. 
 
I have no experience with other commercial packages. 
 
4.  The installation CD uses Linux!  Won’t I have to install Linux on my hard disk too? 
 
No.  This is a Linux LiveCD.  You just insert it in the CD-Drive and reboot.  It runs 
strictly from the CD and memory and does not need the hard drive at all.  You won't even 
know it's Linux except that it doesn’t look like Windows. 
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There is a whole family of what are called "Linux Live" CD's that run strictly from CD.  
They allow you to run Linux without touching the hard disk AT ALL in ANY WAY.  
And, they are very cool! 
 
The only OS's the hard drive will contain are Windows XP and DOS. 
 
5. My computer already dual boots Windows and another operating system (perhaps 
Windows XP and Windows 98).  Should I use this procedure? 
 
Probably not.  If your computer is currently configured to dual boot and is meeting your 
needs, there is no advantage to re-partitioning your disk drive using this procedure.  Also, 
DOS requires a PRIMARY disk partition.  There can only be three or four of these on a 
disk.  Laptops often have a “maintenance” partition as the first primary partition and 
WindowsXP as the second primary partition.  If you have another operating system, you 
may not be able to create a primary partition for DOS. 
 
6.  Why doesn’t the installation CD include an MS-DOS bootable image?  There are 
plenty of MS-DOS images available on the world wide web. 
 
MS-DOS is a proprietary Microsoft Operating System and I cannot legally redistribute it.  
You need a valid license to run it on your computer.  This may be an MSDOS license, a 
Windows98 license, or an EULA (End-User License Agreement) for another operating 
system with a “downgrade” or “upgrade” right.   
 
You can get all of the files you need easily from the web to do the installation, and you 
do not need any license or installation keys, but you do need a license to run it legally.  I 
have transferred several Windows98SE licenses from old, broken computers. 
 
I will tell you how to get the necessary disk image for MS-DOS 7.1 in the Appendix. 
 

Technical Notes about Re-partitioning Disk 
 
I know of only one reliable way to re-size an NTFS disk partition.  This is to use an open-
source program called “ntfsresize.”  There is a commercial product I have used called 
“Partition Magic.”  Version 8.02 of this program DOES NOT work on the NTFS 
partitions I have tried.  YMMV (Your Mileage May Vary). 
 
The easiest way to run ntfsresize is actually from a graphical program.  There are two 
programs available, qtparted and GParted.  We are going to use GParted running on a 
totally Free Linux CD based on the GParted 0.2 LiveCD from 
http://gparted.sourceforge.net. 
 
Even if you don’t know anything about Linux, you can use this CD and tool to shrink 
your existing NTFS partition, create a new FAT partition for DOS, and format the new 
partition.   
 



FreeDOS Installation CD Version 0.91 Beta 
February 8, 2005 

4 

Note: Most desktop partitions delivered with Windows XP pre-installed have one NTFS 
partition which takes up the entire disk.  Some desktop computers, and most laptop 
computers, have a small, often hidden, system partition on the disk before the NTFS 
partition.  Do NOT, under any circumstances, modify, format, resize, relabel, or 
otherwise modify that partition!  Do not reformat or relabel the NTFS partition either! 
 
Caution!!! 
 
NOTE: You should DEFINITELY have a backup of the data on your computer BEFORE 
you perform this procedure. 
 
I am going to provide a very detailed procedure.  However, if you are not comfortable 
with installing programs and rebooting your computer, you may want to get someone to 
help you with this. 
 
You will have to burn “ISO” file images to a CD.  There are various ways to do this.  If 
you do not know how to burn a “bootable” CD from an ISO image, see 
www.k1ea.com/hints, “Creating a Bootable DOS CD.” 
 
Downloading the FreeDOS Installation CD 
 
Go to http://odin.fdos.org/dual/fdinst091.iso.  Download the fdinst091.iso file and save it 
to your desktop.  This file is about 40 Mbytes (Megabytes). 
 

 
 
Burning the FreeDOS Installation CD 
 
You may have CD creation software on your computer that will burn an ISO image to 
CD and create a bootable CD.  For example, Easy CD Creator (Roxio) will do this.  If 



FreeDOS Installation CD Version 0.91 Beta 
February 8, 2005 

5 

not, you can download the “Power Toy” from the Web and use that to burn the CD under 
Windows XP.  For more information, see www.k1ea.com/hints, “Creating a Bootable 
DOS CD.”  Label the CD “FreeDOS Installation CD Version 0.9.”  If you see the file 
fdinst091.iso on the CD, you did not burn the CD correctly and it will not boot.  You 
should see several directories on the CD. 
 
Resizing your NTFS Partition 
Put the CD you just created in your computer’s CD drive and reboot.  Type “livecd” at 
the “boot:” prompt (or just wait ten seconds). 
 

 
 
You will have to select several default items, including language, screen resolution, and 
screen depth.  Press “Return” three times to select the defaults (<OK> button). 
 

 

 
 
Repartitioning the Disk 
 
NOTE: This procedure should work fine for other types of Windows partitions, including 
FAT32, used by older Windows versions.  If you have a FAT32 partition, first use the 
Windows XP utility “Disk Defragmenter” to defragment it.  This is available under 
“Start->All Programs->Accessories->System Tools->Disk Defragmenter.”  This step is 
not necessary if you have an NTFS partition.  Thanks to Paul Erickson, VA7NT, for 
verifying that this works! 
 
NOTE: Ed Parish, K1EP, got the following error: “Filesystem check failed…”  If you get 
this error, it indicates that the NTFS partition has at least one error.  You can fix this by 
booting Windows XP, bringing up a “Command Prompt” (Start->All Programs-
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>Accessories->Command Prompt) and entering “chkdsk /f c: ” at the C:> prompt.  
You will have to reboot your computer. 
 
Now, let’s repartition your disk.  The LiveCD starts the GParted program.  When it 
finishes booting, and GParted finishes scanning your disks, you should see a screen very 
similar to the screen below.  Your disk will have different partitions.  If your disk has an 
EXTENDED partition, like the one shown below, DO NOT PROCEED WITH THIS 
PROCEDURE unless you understand how disks and disk partitions work. 
 

 
 
You should see one or two partitions of the form /dev/hda1 and /dev/hda2.  One of these 
will be a LARGE NTFS partition, like is shown below.  Notice also that the “boot” flag is 
shown for the NTFS partition.  This means that this partition will be booted when the 
computer is started and is thus your WindowsXP partition. 
 
Note that there is a smaller FAT32 partition on this hard drive.  This is a recovery 
partition that HP put on this particular computer.  Your computer may not have a 
recovery partition.  If you do have a recovery partition, don’t do anything with this 
partition except unmount it (see below).  If you DO NOT see only one or two partitions, 
with the LAST partition being a large NTFS partition with the “boot” flag, do not 
continue with this procedure unless you are SURE that you know what you are doing. 
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NOTE:  There is a small control in the upper right corner of the GParted application.  
This allows you to select multiple hard disk drives.  It should not be necessary for you to 
use this control if you are installing DOS on a typical computer with one hard disk drive. 
 
This drive should show up as /dev/hda for a standard IDE disk drive. 
 

 
 
Now, we may have to “unmount” the hard disk partitions.  If either or both of the 
partitions has a white rectangle next to the partition identifier (/dev/hda1 or /dev/hda2), 
right click on the partition and select “unmount.”  The white rectangles are shown on 
both partitions below, and the next figure shows the unmount menu option.  Left click on 
the partition name (/dev/hda1 or /dev/hda2) to select it (it will be highlighted) and then 
right click and select “unmount.”  Unmount any mounted partitions on the disk. 
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This shows both /dev/hda1 and /dev/hda2 as being mounted. 
 

 
 
Next, we need to shrink the NTFS partition by 500 MB (Megabytes).  This is an 
insignificant amount that you will never notice, but is plenty of room for a DOS 
installation!  To shrink the partition, select it with the left mouse button (it will be 
highlighted) and then click the right mouse button.  This must be the large NTFS partition 
with the “boot” flag.  Select “Resize/Move”. 
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The resize dialog shown below will appear.  Enter 500 in the “Free Space Following 
(MB):” block.  NOTE:  The partition /dev/hda2 needs to be the NTFS partition marked 
with the boot flag.  It may be /dev/hda1 on your computer if there is not a rescue or 
recovery partition on your disk drive. 
 

 
 
Press the “Resize” button in the panel above with the left mouse button.  The GParted 
window will look like the one below, with the “Resize” operation listed and 500 Mbytes 
of “Unallocated” space. 
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Select the unallocated space with the left mouse button and with the right mouse button, 
select “New” to create a new partition. 
 

 
 
Under “Filesystem”, select “fat32”.  Verify that it will be created as a Primary Partition 
with a New Size (MB) of 500.  Notice that the partition outline changed color from blue 
to green when the type was changed from ext2 to fat32. 
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Select “Add” in the Create new Partition panel.  GParted should appear as shown below, 
with the new fat32 partition shown after the NTFS partition and two operations in the 
panel below the partitions. 
 

 
 
You have not actually repartitioned the disk yet.  You can select GParted->Quit and 
nothing will be done to the disks. 
 
Are you sure that you have a backup of any critical data from the hard disk?  If so, go to 
the top menu and select the green check mark, labeled “Apply.”  Select the Apply button 
in the dialog box. 
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You will see a progress indication like the one below. 
 

 
 
When you are done, GParted will show the new partition as either /dev/hda2 or 
/dev/hda3. 
 

 
 
In the GParted window, select GParted->Quit to exit GParted. 
 

 
 
Now, we have to change the type of the new partition from W95 FAT32 to W95 FAT32 
(LBA), or type “b” to type “c”.  We will do this using another program called “fdisk.”  
Go to the bottom right-hand corner of the screen and press the terminal icon (black 
square) with the left mouse button. 
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In the terminal window that opens up, type “fdisk /dev/hda ”.   
 

 
 
Enter “p” at the “Command” prompt.   
 
You should see a partition table as shown below.  Note:  This MUST match the partitions 
that GParted showed you.  The last partition MUST be of type W95 FAT32 and have an 
“Id” of b.  You must have an NTFS partition (either /dev/hda1 or /dev/hda2), with an 
asterisk under the “Boot” column. 
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We are now going to change the type of the W95 FAT32 partition to W95 FAT32 (LBA), 
type c.  If the last partition (W95 FAT32) is /dev/hda3 (partition 3), enter “t”, “3”, and 
“c” as shown below.  If the last partition (W95 FAT32) is /dev/hda2 (partition 2), enter 
“t”, “2”, and “c”.   
 
Then, enter “p” at the command prompt and you should see the new type on the correct 
partition.   
 
DO NOT proceed unless this worked correctly.  You haven’t actually changed the 
partition type yet.  Be CERTAIN that you did not change the type of the NTFS partition.  
If you did, simply enter “q” to quit fdisk without writing anything to the disk and start 
over! 
 

 
 
If your partition table is correct, write down the partition table, including values for Start, 
End, Blocks, and ID for all of the partitions.  Finally, at the command prompt, enter “w” 
to write the partition table to the disk. 
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Select the “Reboot” control in the bottom right corner of the screen. 
 

 
 
Remove the CD before the computer reboots.  WindowsXP should boot.   
 
WindowsXP is going to run a utility called “chkdisk” in a special screen when it boots.  
Let WindowsXP run this utility and complete a check on its NTFS partition.  After 
Windows boots, if you select the “My Computer” icon, you will see a new disk drive.  
This drive will be of type FAT32 and about 500 Megabytes.  (You can verify the type 
and size by right clicking on the new disk icon).  Note that you can copy files to and from 
this new disk drive from WindowsXP, which is very cool! 
 
IMPORTANT:  The drive letter (in this case “G:”) that Windows assigns to this partition 
is usually NOT the same drive letter that DOS will assign.  Do NOT assume that DOS 
will use the same drive letters. 
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Install GAG Boot Loader 
 
We are going to install a simple multi-boot loader called GAG.  Put the CD in the CD 
drive of your computer and reboot.  Enter GAG at the boot: prompt. 
 

 
 
GAG should start. 
 
At this point, decide whether you want to install FreeDOS or MSDOS 7.1. 
 
Below, I will show your keystrokes, with the option you are selecting in parenthesis.  
You should see the following GAG screen: 
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Enter the following: 
 
4 (Install GAG) 
 

 
 
Space Bar (Press any key to continue) 
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1 (QWERTY Keyboard) 
 

 
 
F (English) 
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S (Setup) 
 
At this point, you should see the main GAG screen: 

 
 
A (Add a new Operating System) 
At this point, you will see the following options.  Note that you may not have the B 
partition that I had on my laptop and B may be your Windows XP Partition. 
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C (Select NTFS Partition…may be B for you) 
 

 
 
WindowsXP (Enter Description) followed by carriage return. 
 



FreeDOS Installation CD Version 0.91 Beta 
February 8, 2005 

21 

 
 
Carriage Return Key (Password…don’t enter one) 
 
At this point, you can select the icon you want for your operating system: 
 

 
 
C (Select Windows Icon) 
 
Now, add DOS to your menu. 
 
A (Add a new Operating System) 
D (Select MSDOS Partition…may be C for you) 
 
MSDOS7.1 (Enter Description) or 
FreeDOS  (Enter Description) - depending on which you are installing 
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Carriage Return Key (No password) 
E (Select DOS Icon) 
H (Save in hard Disk) 
Carriage Return Key (Acknowledge message with OK) 
 
Remove the GAG CD and reboot.  Enter the digit “2” to boot Windows XP.  You will see 
the GAG boot loader introduction screen show below, with “Windows XP” and 
“MSDOS71” or “FreeDOS” shown as the operating systems.  
 

 
 
NOTE: If you hit “S” for setup, you can add a timer and select an operating system to be 
automatically booted in some number of seconds if you don’t press a key.  If you do this, 
don’t forget to select “H” to save the timer to the hard disk!  Press “2” and verify that 
WindowsXP boots normally. 
 
Installing FreeDOS 
 
Installing DOS on your new Partition  
 
Note:  Some, perhaps all, FreeDOS installers write to the C: partition regardless of your 
disk setup.  DO NOT use an automated FreeDOS installer unless you are certain it will 



FreeDOS Installation CD Version 0.91 Beta 
February 8, 2005 

23 

do what you want.  Use the following instructions to install FreeDOS to the correct 
partition on your disk. 
 
Reboot your computer with the FreeDOS installation CD installed.  Enter “odin1440 ” 
at the boot: prompt. 
 

 
 
Enter “return” to select the default Start FreeDOS option (or just wait about ten seconds). 
 
You should get a DOS prompt A:> . 
 

 
 
Do a “DIR C: ” to make sure that your new partition is correctly mounted.  There should 
be no files or directories.  Note that if you had a rescue partition, and your new partition 
was /dev/hda3, that you may see files on C:.  In that case, do a “DIR D: ”.  You should 
see no files and a size of approximately 500 Mbytes.  If this is not what you see, do NOT 
do the next step! 
 
To install DOS, enter “SYS C: ” or “SYS D: ”, depending on which partition had a size 
of approximately 500 Mbytes and no files. 
 
Now, you need to copy several files to the new partition to make it usable.  I have 
included a batch file to make this easier (install.bat ). 
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You can use the following commands at the A:> prompt.  Note:  I am using D: in this 
example, since that is the drive that DOS assigned on my computer.  If you did a “SYS 
C: ”, substitute C: for D: in the commands below. 
 
A:> D: 
D:> a:\install 
 
Remove the floppy disk and reboot. 
 
Select “3” from GAG to boot DOS.  You should get a DOS prompt “C:> .”  You can 
customize the FreeDOS installation of course, and add whatever utility programs, CD-
ROM drivers, etc., that you want. 
 
Installing MSDOS 7.1 Files  (MSDOS Installation) 
 
If you do not have a floppy drive, you will need to use this disk image to create a 
bootable DOS CD.  See www.k1ea.com/hints, “Creating a Bootable DOS CD” for 
detailed directions on creating a bootable DOS CD from wbootess.exe or odin1440.img 
on a WindowsXP computer. 
 
Go to http://www.nerdlabs.org/bootdisks/ and click on wbootess.exe.  Download this 
program to a convenient folder (I used the Windows Desktop).  If you have a floppy 
drive, insert a floppy in the drive, double click on wbootess.exe and select OK in the 
WinImage Self Extractor.  This will write the image to the floppy disk in a:.   
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NOTE:  If you have a floppy disk drive, you could use Windows to copy the files.  You 
can also use Windows Notepad editor to create the autoexec.bat and config.sys files.  The 
following procedure does this from DOS. 
 
Boot the computer from the wbootess bootable CD or floppy disk.  Copy the following 
files from the floppy disk (or CD) to the hard disk in the appropriate directories, using the 
following commands.   
 
Reboot your computer.  If your computer does not boot from the floppy drive (or CD if 
using a bootable DOS CD), see your computer’s documentation and enable booting from 
floppy (or CD).  You should get a DOS prompt A:> . 
 
Do a “DIR C: ” to make sure that your new partition is correctly mounted.  There should 
be no files or directories.  Note that if you had a rescue partition, and your new partition 
was /dev/hda3, that you may see files on C:.  In that case, do a “DIR D: ”.  You should 
see no files and a size of approximately 500 Mbytes.  If this is not what you see, do NOT 
do the next step! 
 
To install DOS, enter “SYS C: ” or “SYS D: ”, depending on which partition had a size 
of approximately 500 Mbytes and no files.  
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You can now install the rest of the DOS files necessary from a floppy disk or boot into 
Windows XP and copy them onto this partition. 
 
You can use the following commands at the A:> prompt.  Note:  I am using D: in this 
example, since that is the drive that DOS assigned on my computer.  If you did a “SYS 
C: ”, substitute C: for D: in the commands below. 
 
A:> D: 
D:> mkdir DOS71 
D:> copy a:\himem.sys 
D:> copy a:\emm386.exe 
D:> cd DOS71 
D:> copy a:\mem.exe 
D:> copy a:\move.exe 
D:> copy a:\smartdrv.exe 
D:> copy a:\edit.* 
D:> copy a:\format.com 
D:> copy a:\sys.com 
D:> copy a:\fdisk.exe 
D:> copy a:\more.exe 
 
Finally, you need to create an autoexec.bat and config.sys file on the D: (or C:) drive. 
 
D:>  cd \ 
D:>  edit autoexec.bat 
 
Now, type in the following lines.  Then save the file (File->Save) and exit the editor 
(File->Quit).  You can access the File menu using Alt-F. 
 
path=C:\;C:\DOS71 
smartdrv a+ c+ 
 
Now, enter the following: 
 
D:>  edit config.sys 
 
Enter the following lines in the config.sys file: 
 
device=himem.sys /testmem:off 
device=emm386.exe noems 
dos=high,umb 
lastdrive=Z 
buffers=20 
files=40 
 
and save the file.   
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Remove the floppy disk and reboot. Select “3” from GAG to boot DOS.  You should get 
a DOS prompt “C:> .”  You can customize the MS-DOS installation of course, and add 
whatever utility programs, CD-ROM drivers, etc., that you want. 
 


